
Feb. 

2016 

ENG 

 

IPPC FORMATTING GUIDE  
FOR STANDARDS AND  
MEETING DOCUMENTS 

Produced by the Secretariat of the  
International Plant Protection Convention 

 



IPPC formatting guide for standards and meeting documents 

Page 2 of 14   

Contents 

Introduction .............................................................................................................................................. 3 

1. Formatting for the online comment system (draft ISPMs and draft specifications) ........................ 3 

2. Document set-up .............................................................................................................................. 3 

3. Paragraph, character and table styles ............................................................................................... 3 

3.1 Body text styles ................................................................................................................. 3 

3.2 Title pages ......................................................................................................................... 4 

3.3 Headings styles ................................................................................................................. 4 

3.4 Styles for bullets, indents and displayed quotes ............................................................... 4 

4. Styles for particular document components ..................................................................................... 6 

4.1 Tables and figures ............................................................................................................. 6 

4.2 Paragraph numbering ........................................................................................................ 7 

4.3 Headers and footers .......................................................................................................... 7 

4.4 Publication historyies ........................................................................................................ 9 

4.5 Character styles ................................................................................................................. 9 

5. Applying styles with the custom toolbar .......................................................................................... 9 

6. Numbering and unnumbering paragraphs ...................................................................................... 10 

6.1 Numbering paragraphs .................................................................................................... 10 

6.2 Unnumbering paragraphs ................................................................................................ 11 

7. Page breaks and section breaks ...................................................................................................... 11 

7.1 Manual page breaks ........................................................................................................ 11 

7.2 Section breaks ................................................................................................................. 11 

7.3 First-page headers ........................................................................................................... 12 

8. Copying text between documents .................................................................................................. 12 

9. Formatting of supplements, annexes, appendixes and attachments ............................................... 12 

10. General formatting details .............................................................................................................. 13 

11. Formatting Tips .............................................................................................................................. 13 
 



IPPC formatting guide for standards and meeting documents 

Page 3 of 14 

Introduction 

This guide intends to set parameters for formatting of IPPC standards and documents to ensure a 

consistent look and to provide answers to general formatting queries. It is intended for persons who 

have some knowledge of Word and is primarily to be used by IPPC Secretariat staff. An IPPC 

document template (.dot file) has been developed, which contains all the styles described in this 

guide, and should be used to facilitate formatting.  

1. Formatting for the online comment system (draft ISPMs and draft specifications) 

The Online comment system (OCS) does not support all formatting. For this reason, only basic 

formatting is carried out to drafts that are uploaded to OCS.  

ISPMs are formatted fully only after adoption.  

The OCS supports the following items: 

- tables, including the publication history 

- footnotes 

- images (see below about shapes) 

- bullet and numbered lists (treats the list as one paragraph). 

The OCS does NOT support the following items: 

- headers 

- footers 

- page numbering 

- Word automatic table of contents 

- shapes, such as text boxes and Microsoft Word “shapes”. 

These items must be removed or inserted as an image (or other solution). They are currently 

being used as borders and boxes to hold images, but are not supported in the OCS. 

Other items to note concerning the OCS: 

- The document being uploaded should be limited in its use of IPPC Styles (i.e. try to use only 

IPP Normal, IPP Heading1, IPP Heading2, IPP HeadSection, IPP Bullet1, IPP Bullet1Last, 

etc.). Most formatting is not retained (or at least not as the IPPC Word Style) once the 

document is extracted from the OCS with the paragraph numbering included. 

2. Document set-up 

Portrait and landscape: 

Paper size: A4, 297 mm × 210 mm 

Margins: top, 27.5 mm; bottom, left, right, 25 mm 

Headers, footers: 15 mm 

Fonts: Times New Roman, Arial 

Language: English (UK). 

3. Paragraph, character and table styles 

Paragraph styles are described below and illustrated in Figure 1. 

3.1 Body text styles 

Normal: set to 11 pt Times New Roman, justified, single line spacing, widow/orphan control. 

IPP Normal: based on Normal with 9 pt ¶ spacing after. Style for following ¶: IPP Normal. To be 

used for most text. No line spaces should be added between paragraphs. 
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IPP NormalCloseSpace: based on Normal, 3 pt ¶ spacing after, ¶ keep with next (KWN) constraint. 

To be used for the sentence stem above bullet lists, displayed quotations and other such uses where 

the ¶ sits tightly with the text below and will not become separated from it. 

3.2 Title pages 

IPP Title16pt: based on Normal; style for following ¶ IPP Title16pt; font Arial, 16 pt bold; alignment 

centred; indent left 3 cm; indent right 3 cm; 36 pt ¶ spacing after. Used for “INTERNATIONAL 

STANDARDS FOR PHYTOSANITARY MEASURES” with 36 pt ¶ spacing above on draft ISPMs. 

Modified to 26 pt font size for “DRAFT …” document type on cover page of draft ISPMs. 

IPP Title18pt: based on Normal; style for following ¶ IPP Title18pt; font Arial, 18 pt bold; alignment 

centred; 18 pt ¶ spacing after. Used for document title on cover page of draft ISPMs. 

A text box with grey text reading “draft document” is usually added to the cover page during the draft 

stages and needs to be removed from finalized documents. 

3.3 Headings styles 

IPP HEADSECTION: based on Normal, font 12 pt bold all caps; hanging by 1.5 cm; 18 pt ¶ spacing 

before, 6 pt ¶ spacing after, ¶ KWN; tab, left, at 1.5 cm. This is level 1 and appears in TOC 1 style in 

table of contents. Used for Introduction, Background, Requirements and similar headings in 

standards. 

IPP Heading 1: based on IPP Normal, style for following ¶ IPP Normal; font 12 pt bold; left align 

(because some headings are more than one line but justify poorly); hanging by 1 cm; 12 pt ¶ spacing 

before, 6 pt ¶ spacing after, ¶ KWN; tab, left, at 1 cm. This is level 2 (TOC 2 style in table of 

contents). Used for single-numbered headings in standards. Note the numbers are entered manually 

and that title case is used. 

A variant style, IPP AnnexHead, is level 2 and very similar to IPP Heading but has no hanging indent. 

It may be applied to annex headings. 

IPP Heading 2: based on IPP Normal, style for following ¶ IPP Heading 2; font 12 pt bold; left align; 

hanging by 1 cm; 6 pt ¶ spacing before, 6 pt ¶ spacing after, ¶ KWN; tab, left, at 1 cm. This is level 3 

(TOC 3 in table of contents). Used for subsidiary headings (2.1.) in standards. Note the numbers are 

entered manually if relevant and that sentence case is used. 

IPP Heading 3: based on IPP Normal, style for following ¶ IPP Heading 3; font 11 pt bold and italics; 

left align; hanging by 1 cm; 6 pt ¶ spacing before, 6 pt ¶ spacing after, ¶ KWN; tab, left, at 1 cm. This 

is level 4 (TOC 4 in table of contents). Used for subsidiary headings (2.1.2, 2.2.2.1 etc.) in standards. 

Sentence case is used. 

3.4 Styles for bullets, indents and displayed quotes 

IPP Bullet1: based on Normal; style for following ¶ IPP Bullet1; 3 pt ¶ spacing after; hanging 1 cm; 

tab 1 cm, list tab, bulleted at level 1, aligned at 0 cm, tab after 1 cm, indent 1 cm. The bullet is a 

simple hyphen. To be used for bulleted lists except for the last line or any secondary bullet items.  

IPP Bullet1Last: based on IPP Normal; style for following ¶ IPP Normal; bulleted at level 1, aligned 

at 0 cm, tab after 1 cm, indent 1 cm. A level 1 bullet to be used for the last line of bulleted lists to add 

usual ¶ spacing.  

IPP Bullet2: based on IPP Normal; style for following ¶ IPP Bullet1; 3 pt ¶ spacing after; hanging 1 

cm; tab 2 cm, list tab, bulleted at level 1, aligned at 1 cm, tab after 2 cm, indent 2 cm. The bullet now 

used in the May 2010 version of the template is a small bullet (Times New Roman 6 pt). To be used 

for secondary bullet items. If a secondary bullet ends the bullet list, the 9 pt ¶ spacing must be added 

manually.  
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IPP Indent Close: based on IPP Normal; style for following ¶ IPP Indent Close; indent left 1 cm; 3pt 

¶ spacing after; tab, left, at 5 cm. To be used for a group of simple indented ¶ in the nature of a bullet 

list but without bullets. 

IPP Indent: based on IPP Indent Close; style for following ¶ IPP Indent; 9 pt ¶ spacing after. To be 

used for indented ¶ whose complexity deserves usual ¶ spacing and for the last entry in a group of IPP 

Indent Close paragraphs. 

IPP References: based on IPP Normal; style for following ¶ IPP References; hanging indent 1 cm; 3pt 

¶ spacing after. To be used for bibliographies. The last entry can have the usual 9 pt ¶ spacing added 

manually. Sentence case is used for references to articles in journals irrespective of whether the 

journal uses title case). 

IPP Footnote: based on IPP Arial Footnote; style for following ¶ IPP Footnote; Font Times New 

Roman, 8 pt. hanging 0.5 cm; tab, left, 0.5 cm. Used for footnotes. The number should be superscript. 

IPP Quote: based on IPP Normal; style for following ¶ IPP Quote; font 9 pt; indent left 1.5 cm; indent 

right 1.5 cm. To be used for displayed (long) quotations, usually where the quoted text is more than 

30 words or 3 lines. The smaller size and indentation readily differentiates quoted material. Quotation 

marks are therefore not needed. 
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Figure 1. Examples of the template styles in use in an ISPM. 

The paragraph styles are identified at the left and whether or not an adjustment has been made is recorded. The 
aim is to keep paragraphs in their default defined style wherever possible. Hence the two lines of indented italic 
text at the bottom of the figure has added italics but used the two forms of indented paragraph to achieve the 
desired spacing. In contrast, extensive modification has been made to IPP Normal style to achieve numbered 
indented paragraphs in the displayed quote. 

 

4. Styles for particular document components 

4.1 Tables and figures 

IPP Arial: based on IPP Normal; style for following ¶ IPP Arial; font Arial, 9 pt; 0 pt ¶ spacing after. 

Used for figure and table captions and other text where Arial is required. The text may be left aligned 

manually if this is visually better than justified text (e.g. for narrow column widths with figures). 
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IPP Arial Table: based on IPP Arial; style for following ¶ IPP Arial Table; Arial 9pt. 3 pt ¶ spacing 

before, 3 pt ¶ spacing after. Right justified. Used for text in tables.  

IPP Arial Table header: based on IPP Arial Table; style for following ¶ IPP Arial Table header; Arial 

9pt, bold. 3 pt ¶ spacing before, 3 pt ¶ spacing after. Right justified. Used for heading of tables.  

IPP Arial Footnote: based on IPP Arial Table; style for following ¶ IPP Arial Footnote; hanging 0.5 

cm; tab, left, 0.5 cm. Used for table footnotes. The number should be superscript. 

Table format: Cell margins: top, bottom 0cm; left, right 0,19 cm. Wrap text; allow to break; repeat 

header. See Table 1 for an example of a table. 

Table 1. Example of table formatting. Table caption goes above the table using IPP Arial with added 6pt ¶ 

spacing below and a KWN to keep it with the table. A 6 pt space may also be added above. (Figure captions are 
usually placed below the figure or to the side.) 

Column heading 1 Column 
heading 

2* 

Column heading 3 straddling four other columns† 

Column 
heading 

Column 
heading 

Column 
heading 

Column 
heading 

Border for table and heading is 1/4 
pt line width 

data Text entries 
should be 
aligned left 

21 3.121 4 

Internal borders have no line if 
possible 

data 1.2 22 13.234 42 

Column headings other than 
column 1 are usually centred  

data 1.3 23 113.367 4.3678 

Left column is left aligned data 1.4 0.9 1113.456 440 

Data is centred or right aligned 
depending on numerals involved 

data 1.5 0.8 3.523 4.5 

* Table footnotes use IPP Arial Footnote. Avoid using numbers because they may create confusion because footnote cues 
are numbered. Table footnotes restart for every table. 

† Using different types of cues from numbers also help to distinguish other superscript information (e.g. km2). The last 
footnote needs 9 pt space after. 

Preferably, keep all rows together rather than break across a page. If the table does break across a 

page, repeat the header row. It may be appropriate to assign the paragraph constraint of “page break 

before” to the table caption and make the final determination of the table’s position after the text is 

finalized. 

Images: It may be appropriate to assign the paragraph constraint of “page break before” to the table 

caption and make the final determination of the figure’s position after the text is finalized. 

Illustration credits (for examples see “General publication details” on page Error! Bookmark not 

defined.). The text may be small type size and oriented vertically at the side of an illustration or it 

may be included in the caption. 

4.2 Paragraph numbering 

IPP Paragraph numbering: based on default paragraph font; font Arial, 8 pt; blue 255; square 

brackets. Used for numbering paragraphs automatically. (If the style is used outside a table, indent 

before is −1 cm; hanging 1 cm.) See further on paragraph numbering in Section 6. 

4.3 Headers and footers 

IPP Header: based on Normal; font Arial, 9 pt; 0 pt ¶ spacing after on 1st line; 6 pt ¶ spacing after on 

2nd line; bottom border single solid line 0.5 pt width, distance from text 4 pt; tab, right, at 16 cm. 

Landscape: tab, right, at 24.75 cm. Style for following ¶ Header. Used for document headers. 
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The following is applicable to documents for meetings where the first page indicates the document 

number, title, etc., but not to documents with a cover page. 

First page header: Left: Logo and “International Plant Protection Convention”.  

If only the name of IPPC, this is aligned with bottom of logo.  

If two lines (IPPC and title of document), the two lines are aligned with logo (tab 2 cm, logo layout 

square). The second line (title of document): italics. 

Example of a first page header:  

International Plant Protection Convention [Document number] 
[Document title] [Agenda item] 

 

Even page header: [Document number to the left], [Title of document] to the right (not italics).  

Odd page header: [Title of document] to the left (not italics). [Document number] to the right. 

Note drafts shall have a text box with grey text reading “draft document” in the header (left and right 

page headers after the first page) and needs to be deleted from finalized documents. 

Appendixes, annexes, etc have different headers. These have the document title and e.g. Appendix 1. 

Example: Glossary of phytosanitary terms - Supplement 1 

IPP Footer: based on Normal; style for following ¶ Footer; font Arial, 9 pt; 6 pt ¶ spacing after; top 

border single solid line 0.5 pt width, distance from text 4 pt; tab, right, at 16 cm. Style for following ¶ 

Footer. Used for document footers. 

Page numbering (character style): Normal; font Arial 9 pt. Format: [Page x of xx]. Used for page 

numbers in footers on meeting documents, reports, draft ISPMs and specifications.  

The page numbers format for standards (ISPMs incl. PTs and DPs) should be as follows:  

ISPM 15-1; ISPM 15-2; DP 15-3.  

The page numbers for individual ISPMs should not be 1:15 etc. because then the ToC for ISPM 15 

would show 1:15, 2:15, 3:15, which is confusing for finding a particular page.  

This style is also applicable to draft ISPMs going to the CPM. 

For both styles: Odd - right; even - left.  

Contents (table of contents) 

IPP ContentsHead: based on IPP Heading 1; font 12 pt bold; left align (because some headings are 

more than one line but justify poorly); hanging by 1 cm; 12 pt ¶ spacing before, 6 pt ¶ spacing after, ¶ 

KWN; tab, left, at 1 cm. 

TOC 1: based on IPP NormalCloseSpace; style for following ¶ Normal; hanging 1 cm; 12 pt ¶ spacing 

before; tab, right, at 16 cm, leader …. Linked to section headings such as “REQUIREMENTS”. 

TOC 2: based on TOC 1; style for following ¶ Normal; hanging 0.75 cm; indent right 0.5 cm; 6 pt ¶ 

spacing before; 0 pt ¶ spacing after; no KWN; tab, left, at 0.75 cm. Linked to level 1 headings 

(numbered 1, 2, 3 in draft standards). 

TOC 3: based on TOC 2; style for following ¶ Normal; indent left 0.75 cm, hanging 1.5 cm; 3 pt ¶ 

spacing before; tab, left, at 2.25 cm. Linked to level 2 headings (numbered 1.1, 2.1.1, 3.1.1 in draft 

standards). 
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Some tweaking of the automatically generated contents may be needed. The 

entries of the Introduction section of draft standards (e.g. Scope, References, 

Outline of Requirements) should be selected in the table of contents and 

indented to match TOC 3 entries. 

4.4 Publication historyies 

The publication histories should follow the example: 

Publication history (without the title of the standard) 
This is not an official part of the standard 

[History...] 
[Official reference of the standard] 
[LRG modifications] 
Publication history: Last modified [month year] 

Formatting: Font IPP Arial; hanging -0.5cm; right indent at 5.75cm.  

It is desirable to have the publication history on the second page and it can be 

divided into two columns to save space. If too long for the second page, move 

all of the publication history to page three and have the table of contents start on 

page five.  

4.5 Character styles 

Character styles should be applied instead of local formatting as the latter will 

disappear if a paragraph style is applied or updated. The following character 

styles have been created in the IPPCStyles.dot file to be used when emphasis is 

needed: 

- IPP Normal italics (IPP Italics character) 

- IPP Normal bold (IPP bold character) 

- IPP Normal underlined (IPP underlined character) 

- IPP Normal strikethrough (IPP strikethrough character) 

Underlined and strikethrough must be used with attention as these indicate track 

changes: “addition” (underlined) or “deletion” (strikethrough) both in the OCS 

or when draft ISPMs and specifications are commented on in other situations.  

Note that by placing the cursor in the emphasised word and selecting a 

paragraph style, the character style will be annulled. There are also 

“ResetChar”, “ResetPara” and “ClearFormat” commands available on the 

customized toolbar (see Figure 2). 

5. Applying styles with the custom toolbar 

The template (IPPCStyles.dot) includes a customized toolbar. It may be saved 

into a specific document (.doc file format) for circulating to working groups 

during drafting. This is done by opening the template in Word and saving it with 

a .doc name. The template can also be attached to a .doc through wither Tools | Templates and Add-

Ins | Attach [IPPCStyles.dot]+Automatically update document styles; or by clicking on Developer tab 

| Document Template | Attach IPPCStyles.dot. If you do not have the Developer tab, go to the Word 

menu (four coloured button) | Word options | tick off “Show developer tab in the ribbon” 

With the customized toolbar (see Figure 2), paragraph styles may be applied very simply by having 

the cursor in a paragraph and then clicking on the desired style button in the toolbar. 

The lower buttons on the toolbar are also very useful for adding KWN constraints and page breaks 

and for resetting characters or paragraphs to their default characteristics.  

Figure 2. The 

customized toolbar for 
applying paragraph 
styles and other 
commands in the 
IPPC template, 
IPPCStyles.dot 
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Note that the aim in documents based on the template is to use the available styles in their default 

format, keeping the number of manually adjusted paragraphs to a minimum. This allows rapid 

resetting of paragraphs when numbers are applied and removed (see subsection below). 

6. Numbering and unnumbering paragraphs 

This subsection applies to situations where marginal paragraph numbering must be temporarily 

applied, as occurred with draft consultative IPPC documents (e.g. specifications, draft ISPMs, draft 

annexes) before the OCS system was developed. Many of these documents are still in the standard 

setting process. 

If the OCS is used, no paragraph numbering should be inserted in the document which is being fed 

into the system, as this will be generated automatically by the OCS.  

Considering that the OCS strips all formatting of documents, it may prove more efficient transforming 

the draft document into a table, adding a first column to the left and inserting paragraph numbering 

here. The document can then be formatted using IPPC styles. This draft document can be used during 

the consultative process up to the moment of member consultation where it must be re-transformed 

into text and uploaded into OCS.  

6.1 Numbering paragraphs 

The toolbar button IPP Paragraph numbering applies an 8-point, blue, Arial, italic, bracketed, 

marginal number for the consultative process: 

[1] This is an example of IPP List numbering. 

Problems arise when the numbers are automatically added to indented text (bullets, indents, quotes, 

references) and sometimes to the first entries of the manually numbered IPP Heading 1, IPP Heading 

2 styles. 

In order to use the IPP paragraph numbering style, but not having the problems that arise from 

automatic numbering, transform the text into a table. Then add a column before the text column, 

highlight this column and insert automatic numbering with the IPP paragraph numbering format. 

Copy and paste the numbering to e.g. wordpad and re-copy and paste it into the column. Hereby the 

formatting is lost. Re-apply IPP paragraph numbering format. The numbers are no longer up-dated 

automatically. Note that the manually inserted paragraph numbering must correspond to that 

generated by the OCS as the text will, at some point, be fed into OCS and differences in the 

numbering would create confusion. The OCS separates the text by paragraph signs and [1] is linked to 

the general comment, which does not, however, show when a report is made. Therefore, when 

inserting the numbering manually, note that it must start from [2]. 

If the table solution is not applied, note that: 

Bullet styles. These lose their bullets when IPP List is applied. Bulleted lists should be selected and 

reset (reset para command in the toolbar) so their original appearance is restored. This means the 

bullet items are unnumbered but the sentence stem above the bullet items will have a number for 

identification. 

Indent styles (indent, quotes, references). These lose their indentation when IPP List is applied. In 

many cases the change in alignment can simply be ignored during consultation and the paragraphs 

allowed to remain aligned at the margin like IPP Normal style. Otherwise manual indentation can be 

applied. 

For indented paragraphs, if the original appearance is important in the numbered consultation 

documents, go to Format | Tabs | delete tab at 0cm, add tab at 1 cm, then go to Format | Paragraph | 

left indent -0.85 cm, hanging by 1.85 cm (cf. the default unnumbered format with left indent 0 cm, 

none). 
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For references, go to Format | Paragraph | left indent -0.85 cm, hanging by 1.85 cm (cf. the default 

unnumbered format with left indent 0 cm, hanging by 1 cm).  

In the case of displayed quotes, these can simply be reset (use reset para command) to the original 

format without numbering. 

Heading styles. Microsoft Word does not like adding a number and tab for marginal numbering of a 

heading that already has a number and a tab. When the text is selected and IPP List applied, the 

original heading numbers may be wiped even though they have been entered manually. The numbers 

may then have to be re-entered in headings.  

Sometimes the first of the secondary headings (e.g. 1.2) does not show a marginal number but other 

secondary headings below are correctly formatted. In such circumstances, the easiest solution is to use 

Word’s format painter (see Format painter below). 

6.2 Unnumbering paragraphs 

If a table has been used, delete the first column which contains the paragraph numbering, highlight the 

table and transform it into text. 

If automatic numbering has been used, use the reset para command. Care must be taken to revisit 

specially formatted paragraphs and reapply the desired modifications to the underlying paragraph 

style. 

The best option is to have a reference document retaining the original format from before numbering 

was applied, and to gradually unnumber sections of the text in the more recent file (rather than select 

the entire document). If the reference document is open as well as the document being unnumbered, 

then any original specialized formatting may be transferred to unnumbered paragraphs using Word’s 

format painter (see below). 

7. Page breaks and section breaks 

Manual page breaks and section breaks should be kept to a minimum in Word documents. They 

present dangers in terms of pagination or print problems for users whose paper size, font 

characteristics or printer capabilities differ from that expected.  

However, section breaks are necessary when different headers and footers are needed as is the case for 

Annexes, Appendixes, etc.  

7.1 Manual page breaks 

Manual page breaks are preferable to section breaks. (The latter may create problems with headers 

and footers when a document is altered.) However, manual page breaks are not desirable in an 

evolving document because the addition and deletion of text may shift the break to an unwanted place. 

Manual page breaks should rarely be needed in simple documents based on the IPPCStyles template 

because headings styles and other paragraph styles having KWN constraints prevent bad automatic 

page breaks. 

Rather than add a manual page break to ensure a figure or table appears on a particular page, it is 

preferable to link the page break to the particular paragraph (e.g. a table caption above the table or an 

image insertion point). You do this by going to Format | Paragraph | Line and page breaks | Page 

break before. If subsequent changes rule this form of manual pagination unnecessary, you can click 

the ResetPara command in the customized toolbar to remove the paragraph’s page break. 

7.2 Section breaks 

Section breaks should be used sparingly. They are necessary for specifying a right hand page (a new 

leaf) at major divisions of the document allowing a change in the text of headers and footers. Should 

space be at a premium, annexes or appendixes may be run on with the body of a document using page 
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breaks as is done with ISPMs; in other documents often the first (and sometimes each) such 

component is assigned a right-hand page as befits an attachment. 

All new chapters should start on an odd page, but to save paper Appendixes, Annexes, etc. may start 

on an even page. 

One reason for strictly controlling the number of section breaks is the annoyance of managing headers 

and footers if section breaks are subsequently deleted. When you insert a new section, you have the 

option of a first page differing in its header and footer from the surrounding pages.  

7.3 First-page headers 

Should one want a plain header for a new section in a document based on IPPCStyles.dot where the 

normal logo-bearing first-page header is in section 1 (the title page), it is necessary to uncheck the 

“same as previous” condition. The logo header can then be deleted. This will still leave the rule across 

the page (the Header style). If the paragraph is changed from Header to IPP Normal style, the rule 

disappears to leave a plain start to the page. This can then be repeated by using the “same as previous” 

condition for the first pages of subsequent sections. 

8. Copying text between documents 

Copying and pasting text from a source document based on other templates into a newer destination 

document based on the IPPCStyles template may introduce unnecessary paragraph and character 

styles that clutter up the format options and may cause style conflicts or lead to problems with the 

Word document or even corruption of the file. 

One possibility is to copy text from the source document into a blank document and make it all 

Normal style or copy and paste it into Wordpad. Recopy this text and paste into the destination 

document based on the IPPCStyles template. Then assign the IPP paragraph styles as required. 

Another option is to have the intermediate blank document based on IPPCStyles and use “paste 

special” (Ctrl+Alt+V) specifying “unformatted text” to paste the copied text from the source 

document. This gives the opportunity to experiment with applying IPP paragraph styles to an 

unformatted passage to see if it is practicable to carry out reformatting before altering the destination 

document; such an experiment may lead to a decision to copy text directly from source to destination 

document. 

Although this two-stage copy and paste process may take a little more trouble, it will lead to a 

“cleaner”, more professional appearance and fewer problems. 

9. Formatting of supplements, annexes, appendixes and attachments 

The formatting should follow the general rules for the application of IPP styles. Note that attachments 

are usually different kinds of documents and are only named attachments in the header to identify the 

document in meetings (i.e. the title of the document need not include the word “Attachment”). 

Component status note (prescriptive or non-prescriptive status) and adoption note (for added or 

revised annexes etc.): IPP Normal + 10 pt font size (there is no style for this). The note is placed 

above the document title. 

Title: IPP AnnexHead, level 2 and very similar to IPP Heading1 but has no hanging indent. It may be 

applied to annex, appendix, supplement and attachment titles. “ANNEX”, “APPENDIX”, etc. in 

capitals.  

For criteria for the formation, content and change of supplements, annexes and appendixes in ISPMs 

see page Error! Bookmark not defined. on content of ISPMs.  

(Make sure that both the Word document and the PDF document are in the same folder when creating 

a hyperlink. In that way, you can transfer your document to any other computer and as long as the two 

documents are in the same folder together, the link will still work.) 
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10. General formatting details 

Table of contents 

A table of contents should be generated for documents of 10 pages or more, but can also be added for 

shorter documents if it is deemed that it will help the reader to navigate the document. For long 

appendixes, annexes or similar a separate table of contents can be generated by using either lower-

level TOC styles (e.g. TOC 6 to TOC 9) or by delimiting the text using Bookmarks.  

References 

Use the style “IPP References” and refer to the Style Guide, section “References to documents, 

ISPMs, IPPC and FAO” for examples. 

File size 

If needed, a PDF can be created to reduce the overall file size. Circulate Word documents without 

pictures but with picture frames instead where the pictures will go. This allows captions to be present 

in an image-free Word document and editable. 

Tables 

All tables should have a reference in the main text of the document and be numbered sequentially 

according to the order they are referred to in the text. 

The position of the table should be close to the text mentioning.  

A table’s caption is positioned above the table. 

Illustrations, images and figures 

All illustrations, images and figures should have a reference in the main text of the document and be 

numbered in the order in which they are referred to in the text. The position should be close to the text 

mention and preferably be placed at the top of a page. The caption is usually positioned below or to 

the side of the figure. 

Illustrations, images and figures should not include any text because the text needs to be modifiable 

(e.g. for translations).  

Images should be compressed while maintaining the quality. The images are best at 300 dpi for sharp 

printing. Aim for 5–8 cm width. Maximum column width is 16 cm. Crop all unnecessary parts of the 

image. Ensure all text concerning the image (explanatory detail with arrows or call-outs etc.) is 

separate from the image. Group images and objects (e.g. picture+arrows+text) to ensure some parts do 

not shift independently when the layout is modified. 

The illustrations and their associated text must allow translators to easily work on them; that is to 

translate the text, and modify the size of text boxes (as at least French and Spanish take more space 

than English). 

11. Formatting Tips 

Format painter 

Because of the trickiness of numbering and unnumbering (with Word having its own way of doing 

things and a worrying balkiness about obeying the user’s wishes), the use of the format painter tool 

can be a great help. If one numbered heading has been sorted out automatically so that it carries two 

numbers (blue marginal and its own hierarchical identity) but other headings are wrong, click in the 

correctly formatted paragraph, click on the format painter tool (the paintbrush in the main toolbar), 

and then click in the paragraph to be corrected. 

The format painter can also be extremely useful at any time when formatting a document. 
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Format painter can be applied between two open documents, clicking first in the source paragraph 

with the desired format, then clicking the paintbrush in the toolbar, and then crossing to the second 

document and clicking in the destination paragraph to apply the same style. 

Soft return: shift+return 

Non breaking space: shift+ctrl+space 

Copy and paste track changes: turn off “track changes” in both documents as they will otherwise not 

be kept when pasted. 

Degree sign: Insert | Symbol for TimesNewRoman or by using typing alt+numberpad 0176 on a PC 

or shift+option+8 on a Mac. 

Adding Developer tab: 1. Click the File tab; 2. Click Options; 3. Click Customize Ribbon; 4. Under 

Customize the Ribbon and under Main Tabs, select the Developer check box. 

Dot template: Use the Word template IPPCStyles.dot in order to have the full style set available 

(found under Templates, e.g. C:\Users\Moller\AppData\Roaming\Microsoft\Templates and in the 

Style guide folder).  

The easiest way to use the IPPCStyles.dot template if the styles are not in the document on which you 

are working is to do the following: Click on Developer tab | Document Template | Attach 

IPPCStyles.dot. If you do not have the Developer tab, go to the Word menu (four coloured button) | 

Word options | tick off “Show developer tab in the ribbon”. (As noted previously, the template can 

also be attached to a .doc through the main menu: Tools | Templates and Add-Ins | Attach 

[IPPCStyles.dot]+Automatically update document styles.) 

Bookmarks 

Using bookmarks is an easy way to both mark and find specific places in a publication in order to 

quickly return to the section or paragraph.  

Bookmarks are also very useful if an additional table of contents is needed for a part of a publication, 

e.g. where the Annex, Appendix, etc are long. They can be created in the following manner:  

(1) Select all the text for the entire area and then click Insert tab | Links group | Bookmark. 

(2) Type a name for the bookmark and click Add. 

(3) Create a TOC using References | TOC | Insert TOC. 

(4) To modify the field code syntax for the TOC 

 Select the TOC, right-click it and choose Edit field. 

 Click the Field code button and add the following string to the current codes: \b 

bookmark (the result should look something like {TOC\b “bookmark”} ). 

OR 

(1) Click where you want to add a section table of contents.  

(2) On the Insert tab, in the Text group, click Quick Parts, and then click Field.  

(3) Under Field names, click TOC.  

(4) Click Field Codes, and then click Options.  

(5) In the Switches list, click \b, click Add to Field, and then click OK.  

(6) In the Field codes box, type the name of the bookmark for that section.  

(7)  IMPORTANT    Be sure that a space separates the \b switch and the bookmark name. 

(8) Click OK (the result should look something like {TOC\b bookmark\*MERGEFORMAT} ). 

 


